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Legal Notices 

Copyright Notice 

© 2020 Medis Medical Imaging Systems bv. All rights reserved. 
 
This manual is copyrighted and is protected by worldwide copyright laws and treaty provisions. No 
part of this manual may be copied, reproduced, modified, published or distributed in any form or 
by any means, for any purpose, without prior written permission of Medis Medical Imaging Systems 
bv. Permission is granted to freely print unmodified copies of this document as a whole, provided 
that copies are not made or distributed for profit or commercial advantage. 

Trademark Acknowledgments 

DICOM is the registered trademark of the National Electrical Manufacturers Association for its 
standards publications relating to digital communications of medical information. All other brands, 
product, and company names mentioned in this document are trademarks or registered trademarks 
of their respective owners. 

QStrain is a registered trademark of Medis Associated bv.  
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Regulatory Information 

Intended Use 

QStrain is software intended to be used for the visualization and analysis of MR 2D images of the 
heart and blood vessels. QStrain is intended to support the following visualization functionalities: 

- cine loop and 2D review 

QStrain is also intended to support the following analyses: 

- cardiac function quantification 

- anatomy and tissue segmentation  

These analyses are based on contours that are either manually drawn by the clinician or trained 
medical technician who is operating the software, or automatically detected by the software and 
subsequently presented for review and manual editing. The results obtained are displayed on top of 
the images and provided in reports. 

The analysis results obtained with QStrain are intended for use by cardiologists and radiologists to 
support clinical decisions concerning the heart and vessels. 

Indications for Use 

QStrain is indicated for use in clinical settings where validated and reproducible quantified results 
are needed to support the visualization and analysis of MR images of the heart and blood vessels for 
use on individual patients with cardiovascular disease.  

When the quantified results provided by QStrain are used in a clinical setting on MR images of an 
individual patient, they can be used to support the clinical decisions making for the diagnosis of the 
patient or the evaluation of the treatment applied. In this case, the results are explicitly not to be 
regarded as the sole, irrefutable basis for clinical diagnosis, and they are only intended for use by 
the responsible clinicians.  

Limitations 

Currently no limitations have been specified for QStrain 3.2.  
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WARNINGS 

 QStrain must be used by cardiologists, radiologists, or trained technicians who are qualified to 
perform cardiac analysis. If the analysis results are used to reach a diagnosis, the results must be 
interpreted by a qualified medical professional. In clinical practice QStrain should not be used for 
purposes other than those indicated in the section Intended Use. 

 You are explicitly recommended to measure strain parameters only in sequences that are 
validated for strain measurements. Reliable measurement results can only be obtained with 
validated acquisitions. 

 Users must have sufficient proficiency in the English language, read this manual and become 
familiar with the software and be able to obtain reliable analysis results. 

 

Note on Monitor Aspect Ratio and Resolution 

 The shapes of objects and calipers displayed may be slightly distorted when the resolution is 
set to an aspect ratio different than the monitor's physical aspect ratio. This distortion does NOT 
affect the accuracy of measurements or analyses. To avoid distortion, set the resolution of the 
monitor to an aspect ratio equal to the physical aspect ratio. LCD monitors typically operate best at 
their native resolution. Microsoft Windows recommends a resolution when it has sufficient 
information to do so. 
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European Regulations 

 

1639 

 

QStrain is qualified as a class IIa medical device. It complies with the 
requirements of the Dutch Medical Devices Decree (Besluit Medische 
Hulpmiddelen, Stb. 243/1995) and the European Medical Device Directive 
93/42/EEC. 
 

 
North American Regulations 

QStrain has clearance for market in the United States by the FDA (Food and Drug Administration) 
under the provisions of Section 510(k) of the Food, Drug, and Cosmetic Act. 

Caution 

Federal law restricts this device to sale by or on the order of a physician. 

QStrain complies with the requirements of the Canadian Medical Devices Regulations and has been 
licensed as a Class II medical device. 

Other Regulations 

QStrain complies with the requirements of the Japanese Pharmaceutical and Medical Device Law 
and has been licensed as a Class II medical device. 
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Conventions Used 

The following conventions and acronyms are used throughout this manual to indicate mouse and 
keyboard actions and to refer to elements in the user interface. 

Mouse 

Click Press and release the primary mouse button. If you are left-
handed, you may have set the right mouse button as your 
primary mouse button. 

Click and drag Press and hold the primary mouse button. Drag the mouse to 
perform a function. Release the primary mouse button. If you 
are left-handed, you may have set the right mouse button as 
your primary mouse button. 

Right-click Press and release the secondary mouse button. If you are left-
handed, you may have set the left mouse button as your 
secondary mouse button. 

Middle-click Press and release the wheel button or the middle mouse button. 
If you have a two-button mouse, press and release the left and 
the right mouse button simultaneously. 

Double-click Press and release the primary mouse button twice. 

Wheel Rotate the mouse scroll wheel. 

Keyboard 

SHIFT/CTRL+click Press and hold down the SHIFT/CTRL key on your keyboard while 
you click a button or object. 

CTRL+K Press and hold down the CTRL key on your keyboard while you 
press K, then release both keys. 

Typographical Conventions 

 
On the Annotations node of the 
Results pane… 

 
Names of buttons, fields, menus, menu options, and tab names 
are capitalized and in bold. 

Procedures > Text Annotation A sequence of menu options that you select to perform a 
specific task is indicated by angular brackets. 

View > Movie A sequence of menu options that you select to perform a 
specific task, is indicated by angular brackets. 

Label: QStrain Analysis Text that you type or that appears on the screen, such as 

annotation labels, is displayed in Segou UI. 

In the Display tab, select the 
Hide all drawings option. 

Names of buttons, fields, menus, menu options, and tab names 
are capitalized and in bold. 
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Symbols Used 

 Reference: Points to related documentation, or to related 
sections in this document, that may be relevant to your 
situation. 

 Tip: Provides helpful information or an alternative working 
method. 

 Note: Promotes additional information. 

 Caution: Tells you to be careful when performing a task. 

 Warning: Warns you of a potentially dangerous situation in the 
image representation or analysis, which may lead to incorrect 
results. You are advised to follow the instructions to avoid this. 
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Introduction 

1 About QStrain 

QStrain is the Medis software solution designed to support the 2D visualization and quantification 
analysis MR and CT studies. It enables cardiologists, radiologists, and technicians to quantify global 
function and regional strain. 
 
Myocardial function assessment is essential for determining the health status of the myocardium. 
Global assessment of myocardial function is predominantly determined using the ejection fraction. 
Regional myocardial, which isolates deformed wall motion, can be quantified using myocardial 
strain analysis, which is measured as longitudinal radial and circumferential strain. 

QStrain runs as an app in the Medis Suite product. The functionality of Medis Suite, including 
instructions on how to start QStrain and load image data, is described in the Medis Suite user 
manual. The Medis Suite documentation is available from the User documents tab, which can be 
opened as follows;  

• Press F1. 

• Select the  help button. 

• Select the Medis Suite main menu button in the upper right corner  > Help > User 
Documents  
 

1.1 QStrain Usage 

Availability of the product QStrain is dependent on licenses. If you would like to purchase a license 
for one or more of the QStrain applications, please contact Medis. 
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2 Support 

Medis is committed to offering high-quality products and services. If you have questions about the 
software, or if you would like to make suggestions for improvements in the software or in the 
documentation, please contact the Medis helpdesk. 

If you contact the Medis helpdesk by e-mail, mention the name of the software and the version 

number in the subject field. To look up the version number of your software, select  > Help > 
About…. 

North and South America 

Medis Medical Imaging Systems, Inc. 
E-mail: support@medisimaging.com  
Telephone: +1 919 278 7888 (working days 9.00-17.00 EST)  

Europe, Africa, Asia and Australia 

Medis Medical Imaging Systems bv 
E-mail: support@medisimaging.com  
Telephone: +31 71 522 32 44 (working days 9.00-17.00 CET) 
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Getting Started 

3 The QStrain Workspace 

QStrain is launched from the app toolbar, app context menu, or app pane of Medis Suite, by 

selecting the QStrain is app icon . Detailed information on how to start an application and how 
to load series into the application, is described in the Medis Suite user manual. QStrain can also be 
started from QMass. 

This chapter covers the following topics: 

• Overview 

• Toolbars 

• Windows Layouts 

• Mouse Controls 

• Frame selection 

3.1 Overview 

QStrain application consists of four primary windows each representing a step in the analysis 
process. A vertical toolbar to the right-hand side of the application, shows the buttons required to 
complete that step in the analysis process.  

The following list describes both the windows and the steps to complete a generic QStrain analysis.  

• Series & Analysis selection window. 

• Contour Editing window. 

• Analysis window. 

• ED-ES review window. 

3.2 Toolbars 

A vertical toolbar on the right-hand side of the application allows one to navigate through the 
different steps of an analysis. In each step of the analysis process, different icons are shown in the 
toolbar.  

The list below describes the purpose of each icon.  
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Icon 

 
Function 

Series & Analysis Selection Toolbar 

 Forward button 

 Back button 

Contour Editing Toolbar 

  

  

Analysis Toolbar 

 
About Box. 

 
 

 
 

 
Window Width, Window Level 

 
 

 
 

 
 

 
 

 

Modifying the contour for the ED or ES phase.Make a new 
tracing contours from scratch. 

 
Segmental and detailed strain results! 

 
HemoDynamic’s. 

Etc..  



Reference 

QStrain 3.2 User Manual 15 

 
Icon 

 
Function 

Review ED ES Toolbar 

  

 

 You cannot move toolbars to another part of the main application window.  

 You cannot hide toolbars. 

 

QStrain also contains many individual buttons, that are not located in the toolbar. The list below 
describes the purpose of each icon in the application, that is not located in the toolbar. 

 
Icon 

 
Function 

Describe every icon in the application, that has not been addressed in the toolbar overview. 

  

 

 

4 Analysis Selection 

4.1 Series & Analysis Selection 

The opening window presents both the series browser and an analysis selection component. This 
section of the document describes; 

• Loading series 

• Analysis selection 

4.1.1 Loading Series 

A serie, or multiple series can be loaded into QStrain from the Series Browser of Medis Suite. Refer 
to the Medis Suite user manual for detailed instructions. 

QStrain supports short and long-axis MR and CT series. 

To load series from the Series Browser of Medis Suite 

1. Select the set of strain series in the image or text view of the Medis Suite Series Browser. 

2. Click and drag the selected items onto the QStrain application icon. 
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Or, 

1. Double click an item in the image view or text view of the Medis Suite Series Browser. 

Or, 

1. Select all series in the image or text view of the Medis Suite Series Browser. 

2. Right-click above the selected series to open a context menu.  

Choose QStrain. 

This will load the series into the series analysis selection viewport.  

To load series from QMass 

• Select the icon  in the General toolbar in QMass. 

 All the series data loaded in QMass and their related contours that have been created in QMass, 
will be loaded into QStrain.  

 

 QStrain only loads MR and CT DICOM series. 

4.1.2 Analysis Selection 

After loading and selecting a series, each series can be coupled with a given QStrain analysis. 

To couple a series with a SAX Analysis. 

• Drag the series… 

 To couple a series with a LAX Analysis. 

• Drag the series… 

 To couple a series with a yyyY Analysis. 

• Drag the series… 

 To couple a series with a xxxX Analysis. 

• Drag the series… 

  



Reference 

QStrain 3.2 User Manual 17 

4.2 Contour Editing 

When a series has been coupled with an analysis, contours can be added, deleted, or modified in a 
series. This section describes the contour management aspects of a QStrain analysis. 

To continue from the Series Selection window to the Contour Editing. 

• Select the  icon in the toolbar. 

4.2.1 Adding contours 

QStrain  contours are added as follows. 

To add contours to a LAX series Analysis. 

• Select the  to enable point mode contour definition. 

• Start editing by left-clicking the mouse along the endocardium wall. 

• To finish editing, right-click the mouse button. 

To add contours to a SAX series Analysis. 

• Select the … 

 

4.2.2 Removing contours 

QStrain  contours are removed as follows. 

 

To delete contours from a LAX series Analysis. 

• Select the … 

To add contours to a SAX series Analysis. 

• Select the … 
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4.2.3 Modifying contours 

QStrain  contours are removed as follows. 

4.3 Finish Contour Editing 

After contours have been defined, the analysis maybe started. 

To continue from the Contour Editing window to the Analysis window. 

• Select the  icon in the toolbar. 
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QStrain Analysis 

5 Performing a QStrain 
Analysis 

QStrain application supports the following strain related analyses. 

• LV long axis    

• LV short axis    

• Atrial images     

• RV images 
 

 

 

 

 

 

 
 

•  

All analyses share a similar workflow. 

• Loading a Series & Analysis selection. 

• Contour Editing. 

• Completing an Analysis. 

• ED-ES review. 

Additional analysis tools are available 

• M-Mode 
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QStrain Results 

6 QStrain Results 

Each QStrain analysis has the following set of graphs and results that are applicable to that 
analysis.  

• SAX 

• LAX  
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Reporting 

QStrain results are made available in the Medis Suite Results pane and in the Medis Suite report. 

 

Figure 1 Medis Suite Report with QStrain Results 

The Reporting functionality of Medis Suite is described in the Medis Suite user manual. The Medis 
Suite documentation is available from the User documents tab, which can be opened as follows;  

• Press F1. 

• Pushing the  help button. 

• Select the Medis Suite main menu button in the upper right corner  > Help > User 
Documents  

7 Sessions 

The QStrain state can be saved in a Medis Suite session. The session can be reloaded to continue or 
review the analyses. 

The session functionality in Medis Suite is described in the Medis Suite user manual. The Medis Suite 
documentation is available from the User documents tab, which can be opened as follows;  

• Press F1. 

• Pushing the  help button. 

• Select the Medis Suite main menu button in the upper right corner  > Help > User 
Documents   
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  Reference 

8 Shortcut Keys 

When you are working with QStrain, you can use several combinations of keys on your keyboard and 
mouse actions to quickly perform the following tasks. 

Press To 

Layout 

F11 Show or hide the workspace window panes 

Image control 

Middle-click and hold Hide all graphics 

Middle-click and drag, or 

Ctrl and drag 

Pan 

Ctrl+Shift and drag Zoom 

Alt+Shift and drag Stack 

Procedures 

A Create an area measurement 

D Create a distance measurement 

S, or 

CTRL+SPACE 

Create a snapshot 

Esc Stop editing the procedure 

Delete Delete the currently selected procedure 
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Press To 

SHIFT+Delete Delete all procedures 

Navigation Controls 

HOME Display the first time point 

END Display the last time point 

Arrow up Display the previous slice 

Arrow down Display the next slice 

Arrow left Display the previous time point 

Arrow right Display the next time point 

CTRL+arrow left Play cine backward 

CTRL+arrow right Play cine forward 

Esc Stop playing cine 

Page Up Display the previous series 

Page Down Display the next series 

 

9 General References 

Anterior (or ventral) Describes the front or direction toward the front of the body. The toes are 
anterior to the foot. 

 


